WiInCE 5.0 MCS9950 Installation MosChip Semiconductor Pvt Ltd

WInCE5.0 MCS9950 Display Driver Installation:
The following procedure explains how to install the MCS9950 display driver.

Before we start we divide the whole process into three steps:

1) Selecting the required “OS design components” (optional).

I1) Adding MCS9950 driver to the “OS image” being built (mandatory).

I11) Reserving memory of 3MB in DRAM so that can be used for DMA operations
of mcs9950 display driver(mandatory).

1) selecting the required “OS design components”
1. Obtain a copy of “MCS9950Ce50” WInCE 5.0 driver package and extract it to your
computer.
Copy the extracted “MCS9950Ce50” folder to %WINCEROOT%\PLATFORM\
(Example: C:\WinCE500\Platform or F:\ WinCE500\Platform).

2. Start WinCE Platform Builder, select File, and open New Platform.

3. Enter a Name for Workspace and press Next

4. When you see Board Support Packages, Design Template, Applications & Media,
Networking & Communications, select what you need to build your own environment.
Then Completing the New Platform Wizard window will open to indicate that it has
finished creating a new platform. Click Finish to complete the setup.

Mew Platform Wizard - Step 4 g|

Design Template b
A design template iz a pre-defined selection of Catalog items. o

Axailable design templates: Chooze the design template that iz most
Custom Device I:|I:IS.E|_|,| aligned with the purpose of your target
Digital Media Receiver device.
Enterprise Terminal Provides the starting point for a range of
Enterprize "web Pad perzonal digital asziztants [PDAz] or mobile
G ateway devices with a clamzhell-and-kepboard
Industrial Contraller design.
Internet Appliance
IP Phohe
b obile Handheld
Set-Top Box
Tirw Kermnel
Windows Thin Client
@ [ < Back ” Mest > ] [ Einizh ] [ Cancel

Note: Make sure we select Mobile handheld as design template
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Mew Platform Wizard - S5tep 5

Apphcations & Media

Select items for applications and media to include in pour 05 design.

MosChip Semicond

3

uctor Pvt Ltd

@

[tems:

MET Compact Framewark
ActiveSync
Quarter YA Resources - Partrait Mode
[] Standard SDE for Windows CE
YWindows Media Audio/MP3
[ Windows Messenger
[ ] *ordPad

Internet Browser

[] Microsoft File Viewers

[ ] *indows CE Eror Reporting

Local plavback support for Windows Media
Audio and MP3 files in a gmall footprint.
Includes DirectShow, Windows Media
Technologies, and codecs. Windows Media
Player iz not included.

Eztimated size of these items: 5535 KB
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Mest = Einizh ] [ Cancel ]

Mew Platform Wizard - 5tep &
Metworking & Communications

deszign.

Select itemz for networking and communications bo include in your 05

X]

@

[terns:

TCPAPvE Suppart
= Local &rea Mebwiork, [LAM]
Wired Local drea Metwark
[] 'wireless Local Area Metwork [802.71
= | Perzonal Area Metwark [PAM]

[] IiDa
= Wide frea Metwork, [Wak]|
Dial-up Metwarking [RAS/PPP]
[] wirtual Private Metwarking

< | &

A short-range wirelezs technology that
enables data communication between
devices. Provides the capability for using a
Bluetoaoth-enabled cellular phone as a data
maodem, exchanaging information with ather
Bluetooth devices, and providing network:,
ACCEDE.

Estimated size of these items: 5357 KB

@
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Mew Platform Wizard - Step 7

Completing the New Platform Wizard

You have successfully completed the New Platform Wizard.

You have created an 05 design for a Windows CE-based
platform. By default, Platform Builder provides a Debug
configuration and a Release configuration of this 05 design.

Options:
# Modify build options for the Debug and Releaze configuraticng of your 05
design without clesing this wizard.

To close this wizard. click Finish.

@ et uinish | [ Canicel
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Add windows media player and required codec’s.
a) View->Catalog->CoreOs->WIinCE devices->Graphics and Multimedia technologies
->Media players->Windows media player, right click mouse and add to os design.

Figure illustrates Step: a

Catalog

= Catalog -~
[ B5Ps
=5 Core 05
=gy Windows CE devices
[ Applications and Services Development
[ &pplications - End User
[ Communication Services and Metworking
[ Core 05 Services
3 Device Management
[C3 File Systems and D ata Store
[ Fonts
=5 Graphics and Multimedia Technologies
[ Audio
[ Graphics
=3 Media
L3 4udio Codecs and Renderers
(£ Digital Rights Management
[ DirectShow
L3 DvDWideo
[ Media Formats
a Streaming Media Playback,
[2] “ideo Codecs and Renderers
=45 Windows Media Player
whindmys Media Player
ﬂ whindows Media Player OCx
ﬂ whindomas Media Technologies
a Wwfhdd and MP3 Local Plavback,
a Wfbdd, and MP3 Streaming
3 Intemational

[ Intemet Client Services
[nil s T S
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b) Click Video Codec’s and Renderers->WMV/MPEG-4 Video Codec, right click mouse
and add to os design.
¢) Similarly add MPEG-1 video Codec as well.

Figure illustrates Step: b and Step: ¢

Catalog

= Catalog ~
[ BSP:
=43 Core 05
=gl Windows CE devices
(3 &pplications and Services Development
[ &pplications - End User
[ Communication Services and Metworking
[ Core 05 Services
L1 Device Management
[C File Systems and D ata Store
[ Fonts
=5 Graphicz and Multimedia Technologies
[ Audio
[ Graphics
=23 Media
£ Audio Codecs and Fenderers
[Z3 Digital Rights M anagement
[ DirectShow
£ DvDwideo
[ Media Formats
[ Streaming Media Playback
=43 Video Codecs and Benderers
DirectShow Video Renderer
MPEG-1 Video Codec
M5 RLE “Wideo Codec
Owerlay Mixer
Wideo/Image Comprezsion Manager
ik AMPEG-4 YWideo Codec
[ Windows Media Player
ﬂ Wbt and MP3 Local Plapback,

|5 DT R ) o T I o PR N

Note: Adding media player and respective codec’s allow us to play video on
WinCE device.
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1) Adding MCS9950 driver to the “OS image”

5. Select “File”->"Manage Catalog items”->

Figure illustrates Step: 5

CEPC1 - Platform Builder [run]

Fie Edit View Broject Platform Target BuldProject BuldOS Debug Tooks Window Help

jew Platform. .. Chr

” [ New Project or File...  Ctri+Shift+M
|| & open... o

PR &G

” Open Workspace ..
Saye Workspace
[ e anenses

| 52 %0 % |0
Cr}
Clrl:
Recent Files » pl Diivers
Recent Warkspaces »
Exit

g D5Desirivien | g PerameleiVion | 78 ClassView | ] Fieiew

el

The Kernel Debugger has been disconnected successtully
The Kernsl Debugger is waiting to_connect vith target.
D:0 TID:0 RTC — Status Reg B — 0x02
0 PID:0 TID:0 X86Init dome, OEMAddressTable = 80222783
26 PID:a3fcadcé TID:alfcad96 OEMIoControl
263 PID:a3fcadch TID:adfcad96 OEMIoControl
263 PID a3fcadcé TID:adfcad96 OEMIoControl

2608 PID: 439932 TID:43fa2ade USED: DIL attach+++Moschip+++

6332 PID:43f99e3e TID:B3slflas NDISPWR:: Found adapter [VHINI1]

[>T Buid % bebug (Log 3, FindinFies1 % Find /<

LT —
' RIS

445922 PID edchbci? TID:e3c?7eba CKITLConnection: ReadBytes — CallKitlRecw failed

Insupported Code 0=x101008c - device 0=0101 func 35
Unsupported Code 0x10100d0 - device 0x0101 func 52
Insupported Code 0x10100£f8 - device 0x0101 func 62
490 PID:43f99e3e TID:43faZade DeviceFolder:  LoadDevice!Enunerate Found deprecated load
2150 PID:43i99=3e TID:43fa2ade DeviceFolder: :LoadDevice!|Enumerate Found deprecated load

5410 PID 'e3e31fbe TID:e3£39842 1yg. p: Layout Hamager successfully initialized to 1
BO066 PID: 63d87306 TID:c3df3fak Exploreri(V2 0) taskbar thread started

instructions at (Drivers“BuiltIn“AFD)
instructions at (Drivers“BuiltIn“FPP).

[

Driver cannot be unloader
Driver cannot be unloade

Mariages Catalog bems

uneeruddin - ... 2 Mig

6) Click “Import”.

Manage Catalog ltems

Figure illustrates Step: 6

Imported .cec files:

File Yerzion Wendar
Qeneric. cec A.00 Microsoft
audin.cec 5.00 Micrazaft
dizplay.cec R.00 hizrozaft
1394 cec 5.00 Microsoft
kevbmouse.cec  5.00 Microsoft
netcard.cec 5.00 Micrazaft
irda.cec A.00 Microsoft
parallel. cec h.00 kicrozaft
pCi.cec A.00 Microsoft
pCmcia. cec 5.00 Microsoft
printing. cec R.00 hizrozaft
zenial.cec 5.00 Microsoft
smartcard.cec 5.00 Microzoft
shorage. cec 5.00 Microsoft
uzb.cec A.00 Microsoft

Dezcrption

Generic driver type declaration
Audio Catalog lkems

Dizplay Catalog [tems

IEEE 1334 Driver Suppaort
K.evboard and Mouse Catalog ltems
Ethernet Catalog [temsz

Il Catalog tems

Farallel Port Catalog [tems

FCl Bus Catalog ltems

FCMCIA Catalog ltems

Frinting and Frinter Drivers

Sernial Port Catalog tems

Smart Card Support and Dirivers
Storage Device Support and Drivers
USE Catalog lkems

[Tl i "

[

(£

Bemowve

Refrezh
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7) Browse to the Platform folder Select the required Project (eg: MCS9950Ce50)

Figure illustrates Step: 7

Import Catalog Items

Look in: | () PLATFORM “| @ & @E-
Ty |5 Armeepb9zaeis 562 _vR4131
i 23 IS ASPEN [C3)5G2_YRE500
My Recent CIBCMI11015P [C3)5MDE2410
Documents | |[C5)CEPS I3 5tpe_atlas
= [CTycommc [C3)5tpe_consurmer i
[ ICDEALL000 [C)5kpe_vega
Desliip ICTDEALUL100
ICTDEALLS00
. ICIDME4
____) ICTIEMULATOR
GECDE
by Documents =
[CTIMATNSTOMETT
) [IMCS9E65Ce50
g! [CMCs2901Ces0
: (&1 M5 995050
by Computer
‘% File name: | hd | [ Open ]
kA Metwork, Files of type: | Catalog Item Files [~ cec) W | [ Cancel ]

8) Browse for the CEC file in the project (eg: MCS9950Ce50.CEC)

9) Click Open
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Figure illustrates Step: 8 and Step9:

Import Catalog Items

Look jr: | (2 MC59350Ce50 “| @2 = @E-
i, Ihabj
{ 23 Cyxae
by Fecent =6 MCS9950Ces0, CEC
Documents
?—[“:
Dezktop

by Documents

©

ky Computer

File name: MC53950Ce50.CEC v [ open |

@

My Metwork, Files of type: | Catalog Item Files [* cec) e | [ Cancel ]
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10) View ->Catalog

Y Y

Resoures Indudes,
_— " | onEpopEe|vim
Full Screen
s |=E\|QE\DH‘EI‘
Workspace A+
OSDesign View  Chrl+Al+ShiFt+E ‘
A Parameter View  Ctrl+alt+Shift+p
Class Yiew CerHAk+Shift+C

Resource Vi

Chrl+-Alb+BhifEHR.

File: View Chri+Ale+Shift -+

Standard Target Status

i T S O

Debug Windows 3

fvers]

Bropertiss

o= |

(1 Paralel

(A PC Cad

[ FCiBus

[ Printer Devices

" B 05Dsiarview [ Pararvetetvien | %1 Closstion | =) Fetiew

145922 PID =3chbcf2 TID:=3c77eba CKITLConuection: ReadBytes — CallKitlRecv failed
The Kernel Debugger has been disconnscted suocessiully
The Kernel Debugger is waiting to connect with targst
0 PID:0 TID:0 RTC — Status Reg B — 0x02
0 PID:0 TID:0 ¥86Init deme, OEMAddressTable - 8022788,
2% PID a3fcadct TID:adfcaddf OEMIoControl: Unsupported Gode 0x101008c — device Dx0101 func 35
263 PID:a3fcadck TID:al3fcad96 OEMIoControl: Unsupported Code 01010040 — device 0x0101 func 52
263 PID:a3fcadcé TID:a3fcad®6 OEMIoControl: Unsupported Code 0x10100£8 — device 0x0101 func 62
490 PID:43f992%e TID:43falade DeviceFolder  LoadDevice|Enunsrats Found deprecated load instructions at (DriversiBuiltIn“AFD). Driver csanot be unloadsc
2150 PID'43{99e3e TID:43fa?ade DeviceFolder  LoadDevice!Enunerate Found deprecated load instructions at (Drivers“BuiltIn“PPP). Driver cannct be unloade
2608 PID 43f99e3e TID:43fa2ade USED: DIL attach+++Moschip++
5410 PID:e3edlfbf TID:=3£99842 Lyg.p: Layout Mamager successfully initialized to 1
6066 PID'63dB7306 TID:cid63fab Exzplorer(V2.0) taskbar thread started
k333 PID 43f99e3e TID:83elflae NDISFUR Found adapter [VMINI1]

*

[1£3

Lo |x

[» [, Buia % Debug Find in Files 1 €| i 3

Opens the Catalog Browser
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11) In the third party->Device Drivers->Add to OS Design
Figure illustrates Step: 11

Samplel - Platform Builder

XA

CE Device || Ba 2= 3 | l|

B U@ | oem | - - | R | G Vaabee | T |
CEPC: x86_Relsase v|| it |Dl A |

“Eile Edit Wiew Project Platforrn Target Build Project Build OS5 Tools MWindow Help

== Catalog
SLWINC & Catalog
Ij; ActiveSyr 1 BSPs
& File Sync (3 Core0s
[ CaB Fils Insts @ Device Drivers
& Help 3 Platform Manager

=423 Third Party
@ [ BSPs
= @ Devlce Dirivers

[ Applications and !
- [L1 Communication $
#--[[1) Core 05 Services
[#1--[_1 File Systems and
-0 Fonts =
[0 Graphics and bul
[ International

[+ [ Intemet Client Sen
[ Security

[+ [ Shell and User Ini

.
= 1 Metworking

Refresh Catalog
Eind

v Docking View
Hide

=l[idded the Windows Hedis Streaming over HITP feature [(SYSGEH_LDSHOW_WHT _HITF) to the pl biedy
_Aladded the Windows Hedia Streaming owver HMS feature (SYSGEH_DSHOU_WHT _MMS) to the plat EE" Properties
Added the Credential Manager feature (SYSGEN _CREDMAN) to the platform

Added the Minimal GWES Configuration feature (SYSGEH_MINGWES) to the platform
Added the Minimal GDI Configuration feature (SYSCGEN_MINGDI) to the platform.
Added the Minimal Input Configuration feature (SYSGEH_MININFUT) to the platform.
Added the HMinimal Window Manager Configuration feature (SYSCGEH_MIHWHCGE) to the platform.
Added the Common Dislog Support feature (SYSGEN_COMMDLG) to the platform

Added the Control Panel applets feature (SYSGEN CTLPHL) to the platform

Added the Software-ba=sed Input Fanel Driver feature (SYSGEH_SOFTEE) to the platform
Added the Common Control feature (SYSGEN_COMMCTRL) to the platform.

Completed the feature and driver list update successfully.

&[S

Debug 3 Log 3 FindinFiles 1 3 FindinFiles 2 7 Tl i >

ds the selected feature to the platform
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12) Make Sure in Workspace by clicking tab->0OSDesignView->Expand Device Drivers
You can see the added mcs9950 driver.

**Note: Make sure that it has the “red arrow down” as in the figure, it means that it is
included in the image.

Figure illustrates Step: 12

~|| % 5= 5 B
L S | mE DR GVeste ~/| %
| CEFC: 486 Relzace v|| tu | [yl it
Il le Edit View Project Platform Target Build Project Buld OS Tools Window Help
=88 Samplel Catalog items ~ =] Catalag

-  CEPC: <06 [ (1 BSPs
23 Device Drivers ® [ Core 05
# (1 Audio - Devies Drivers
+ [ Display -] Platform Manager
+ [ Input Devices =42y Third Party
=43 MOSCHIF SEMICONDUCTOR PYT LTD-3550 -1 BSPs

- CONDUCTOR =24 Dewice Drivers

#- [ Netwarking B [ [MOSCHIF SEMICONDUCTOR PYT LTD-3950]
&3 PC Card (L1 Networking
= [ PCIBus
+ (3 Serial

i H (17 Storage Devices

=1y Mobile Handheldiwindows CE devices]
=423 Applications - End User

= [y tctiveSyne v
a D5DesignVfiew J@ Palametar\f’lewj‘zﬂ ClazsWiew ] E‘I Flle\u"lewj
#|[&dded the Hinimal GDI Configuration feature (SYSGEN MINGDI) to the platform Y

_|added the Minimal Input Configuration feature [SYSGEN_MININPUT) to the platform.

Added the Hinimal Window Manager Configuration feature (SYSGEN_WINWHGR) to the platform.
Added the Common Dialog Support feature (SYSGEN_COMMDLG) to the platform

Added the Control Panel Applet=s feature (SYSGEH_CTLFHL) to the platform

Added the Software-bazed Input Panel Driver feature (SYSGEN_SOFTEE) to the platfiorm.
Added the Common Control festure [(SYSGEH _COMMCTRL) to the platform.

Completed the feature and driver list update successfully.

v
1 L. _’,\%\ Build § Debug 3 Log Find in Filz= 1 )\ Find in Files 2 |'( | > it
Press F1 for Help |Size: ~12361 KB M =0 66

pp—— . - r r " - ™
4 Start ~ -Fl... : # [ 4l | M
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13) Make sure you see the Project included automatically in the Project’s tab as shown in
figure below.

Figure illustrates Step: 13

Sample1 - Platform Builder

R Rl
“cs Device

(A U@ ) ee o o EE R Ve vI|%

J CEFC: 456 _Relsase v| a % | Oy |

|§Ei|e Edt View Broject Platform Target BuldProject Buld 05 Tools Window Help

R Catalog
=-B8 C:vwINCESD | = B Catalog
[ PLATFORM (1 BSPs
[ PRIVATE - Core 05
=2 public -] Device Drivers
i:i’ Favoiites [ (1 Platform Manager
= Projects = /=3 Third Party

[ BSP:

=23 Device Drivers
b n [MOSCHIP SEMICONDUCTOR PYT LTD-3350|
[ Netwarking

a O5Dezignyiew ! @ Parametert/iew '{j Classiew

FileWiew |

|

2[Added the Hinimal GDI Configuration feature (SVSGEN _MINGDI) to the platform

_lltdded the Minimal Input Configuration feature [SYSGEN_MININFUT) to the platform.

|| |added the Hinimal Window Hanager Configuration featurs (SYSGEN_HMINWMGR) to the platform.
Added the Common Dialog Support feature (SYSGEN COMMDLG) to the platform.

Added the Control Panel Applets feature (SYSGEN CTLPHL) to the platform.

Added the Software-based Input Panel Driver feature (SYSGEN_SOFTEB) to the platform.
Added the Common Control feature (SYSGEH_COMMCTRL) to the platform.

Completed the feature and driver list update successfully

T[4, Build { Debug % Lo % FindinFiles 1 %, Find in Files 2 i >

Press F1 for Help
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111 Reserving memory of 3MB in DRAM

14. In ParameterView->CEPC->Hardware Specific Files->Click “config.bib”

Add this line:
Before adding this line in “config.bib”
#elif defined IMGRAM32
; 32 MB of RAM (note: AUTOSIZE will adjust boundary)
NK 80220000 009E0000 RAMIMAGE
RAM 80C00000 01400000 RAM

After adding this line in “config.bib”
#elif defined IMGRAM32
; 32 MB of RAM (note: AUTOSIZE will adjust boundary)
NK 80220000 009E0000 RAMIMAGE
RAM 80C00000 01400000 RAM
DISP_BUFF 9F100000 00300000 RESERVED; 497MB to 500 MB
We define “9F100000” as RAM offset for display buffer for DMA operations of
Display driver.
Note: Now we are done with all the three stages.
15) Now we are ready to build the image. Click “Build OS”->"Build and Sysgen”
Figure illustrates step: 15

5 CEPC1 - Platform Builder,

Fie Edit Wew Project Platform Target Build Project |Buld o5 T
: e | v & | i | f
B EEHP | 2R D2 |E

CEPL: #36_Release

7, |[cEDavies | 5 5'g|:|

2|2l |w CleanBefore Building

alx

=83 c \WINEESDD |w Copy Files to Release Directory After Build = E [Catalog |
v Make Run-Time Image After Buld & (1 BSPs
@] Core 05
Copy Files to Release Directory. (] Device Drivers
Make Run-Time Image: -] Platform Mariager
(=423 Third Party
253 [ BSPs
=] ﬁ Devi
Batch Buid...

i] Moscl’\\p PC\ to Serial and Parallel Drivers
B Open Releass Director:

Set Active Configuration. ..
Canfigurations. ..

Lelx

idded the Hininal GDI Configuration feature (SYSGEN_KINGDI] to the platform

idded the Minimal Input Configuration feature (SYSGEN_MININFUT) to the platforn

Added the Mininal Uindov Manager Configuration feature (SYSGEN_MINUHGR) to the platforn
Added the Comwon Dialog Support feature (SYSGEN_COMKDIG) to the platform

Added the Control Panel Applets feature (SYSGEN CTLFNL) to the platform

Added the Softvare-based Input Panel Driver feature (SYSGEN_SOFTKB) to the platforn
hdded the Oowacn Ocmtrol festure (STSGER COMMCTRL) to the platfor

Added the Real-time Communications (RTC) Client API feature {SYSGEN_VOIP) to the platform
Conpleted the feature and driver list update successfully

>

[ [T Buitd { Debug 5 Log 3, Findin Files 1y, Find || € |

Builds fles i the tree for this 05 desian and then 1uns the Sysgen tool, and builds projects | Size: “19451 KB 36
74 start 45 CEPCI - Platform Buil... 7 Sved Muneeruddin- ... 7} Migration Problems fr... & 11 Windows Explorer  + | T 1
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16) Ensure that we get zero errors; transfer the image to the CE device

Note: If one has the Image already built then they need to follow the steps
From Step: 5 to step: 16



